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ABOUT GloBEIS 
 
GloBEIS, short for the Global Biosphere Emissions and Interactions System, was developed by 
Dr. Alex Guenther at the National Center for Atmospheric Research (NCAR) and Stella Shepard, 
Gary Wilson and Dr. Greg Yarwood at ENVIRON International Corporation (ENVIRON).  The 
idea behind GloBEIS is to provide a biogenic emissions modeling system that embodies up-to-
date scientific information in a package that is easy to use, easy to update, and compatible with a 
wide range of input data (hence “Global”).  The development of GloBEIS is described in 
Yarwood et al. (1999). 
 
The GloBEIS computer code and this “User’s Guide” can be downloaded from the GloBEIS web 
page at www.globeis.com.  Neither ENVIRON nor NCAR make any undertaking to maintain or 
support GloBEIS.  However, you can email questions, comments or suggestions to: 
globeis@environ.org.  Messages sent to this address will be forwarded automatically to Dr. Alex 
Guenther, or he can be contacted directly at guenther@ucar.edu. 
 
The GloBEIS program is free software; you can redistribute it and/or modify it under the terms 
of the GNU General Public License as published by the Free Software Foundation; either version 
2 of the License, or (at your option) any later version. 
 
The GloBEIS program is distributed in the hope that it will be useful, but WITHOUT ANY 
WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR 
A PARTICULAR PURPOSE.  See the GNU General Public License for more details.  To obtain 
a copy of the GNU General Public License write to the Free Software Foundation, Inc., 59 
Temple Place - Suite 330, Boston, MA  02111-1307, USA."   
 
 
COMPUTER REQUIREMENTS 
 
The GloBEIS model runs under Microsoft Access on Windows-based personal computers.  
Ensure that you have sufficient computer memory (1 GB recommended) and disk storage for 
your application.  Insufficient memory may cause slow model run time.    GloBEIS version 3.2 
was developed in Microsoft Access 2000 and we recommend that you use Access 2000 or 
higher.   
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CHANGES FOR GloBEIS3.1 
 
The following changes were made for GloBEIS3.1 relative to GloBEIS3: 
 

• Added options to speciate VOC emissions as CB4, SAPRC99 or native speciation, rather 
than just CB4.   

• Updated the under-lying speciation for other VOC (OVC) emissions. 
• Simplified an option used to adjust isoprene emissions by an arbitrary factor via the 

“model parameters screen” by replacing two GloBEIS3 parameters (Database Max Iso 
EF and Revised Max Iso EF) by a single parameter (Adjust Isoprene Emissions) that has 
a default setting of 1.0.   

• Strengthened some of the internal data consistency checks in the QA module. 
 
CHANGES FOR GloBEIS3.2 
 
The following change was made for GloBEIS3.2 relative to GloBEIS3.1: 
 

•   Added option to speciate VOC emissions for the CB05 chemical mechanism (Yarwood et 
al, 2005). 

 
 
GETTING STARTED 
 
To run the GloBEIS model, first open Microsoft Access 2000.  From the “File” menu, select 
“Open Database…” An open-file dialog will appear that will enable you to locate your GloBEIS 
database.  In the distributed version of GloBEIS3.2 this file is named “globeis_v3.2.mdb.”  
Select this file to open. 
 
When the GloBEIS database is opened, the database window is minimized and two screens are 
opened.  The first of these screens is called the “GloBEIS Banner” (Figures 1, 2), which allows 
you to run selected portions of the model.  The second screen is the “Model Parameters” screen 
(Figures 3, 4, 5, 6), which allows you to change model inputs. 
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Figure 1.  The GloBEIS Banner Screen if all GloBEIS3 options selected. 
 
 

 
Figure 2.  The GloBEIS Banner Screen with BEIS2 option selected. 
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Figure 3.  Example Model Parameters Screen if “BEIS2” model is selected. 
 
 

 
Figure 4.  Example Model Parameters screen if “modified BEIS2” model is selected. 
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Figure 5.  Example Model Parameters screen if “GloBEIS3” model is selected. 
 
 

 
Figure 6.  Example Model Parameters screen: Input/Output Files selected.  
 
 
RUNNING GloBEIS:  THE BANNER SCREEN 
 
To run a GloBEIS module, point your mouse in the check box next to the module name and click 
so that a check mark appears in the box.  The number of modules that can be selected depends on 
the options that have been selected in the model parameter screen.  The modules are visible on 
the banner page only if they are needed for the selected set of options. For example, if the BEIS2 
model is selected then only the modules shown in Figure 2 are visible.  When you have selected 
all the modules you want to run, click the “Run Modules” button.  The model will then run each 
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of the modules you have selected in the order they appear on the Banner.  If you have not yet run 
a module that is necessary to run a subsequent module, such as importing the inputs before 
calculating emissions, the model will inform you of the error.  Do not forget to clear checks from 
module boxes that you do not wish to run again.  The functions of all of the elements of the 
Banner screen are described below. 
 
The modules that can be selected from the Banner have four types of function: 
 

• Modules 1-4 are for loading the data needed to calculate all biogenic emissions 
• Modules 5a-5e are for loading the data needed to calculate biogenic emissions if certain 

options are selected (e.g., leaf temperature, drought, antecedent temperature) 
• Modules 6-9 are for QA, calculating emissions and exporting the results 
• Module 10 cleans up the database after an emissions calculation 

 
Module 1: “Import Domain Definition”, must be run first because it defines the geographic area 
for which emissions are to be calculated.  The domain can be a list of grid cells or a list of 
counties, as discussed further under file formats.  For convenience, the geographic objects in the 
domain are referred to as cells even though they do not have to be grid cells. After this file has 
been imported into GloBEIS the data are stored in table in the Access database called 
“DomainDefinition”. 
 
Module 2: “Import Land Use”, must always be run to define the land use for all the cells in the 
domain. After this file has been imported into GloBEIS the data are stored in an Access Table 
called “Land Use”. 
 
Module 3: deals with preparing the data on solar radiation needed to estimate isoprene 
emissions.  The isoprene emissions calculation is based on Photosynthetically Active Radiation 
(PAR).  The user has three options for specifying the PAR for each cell at each hour: 
 

1. Input a file of PAR values in W/m2 
2. Input a file of cloud cover and have GloBEIS calculate PAR 
3. Use the “simple inputs” option described below to specify a diurnal profile of cloud 

cover which GloBEIS will use to calculate PAR. 
 
The PAR data are stored in an Access Table called “PAR”.  The option to directly input PAR 
data or to use cloud cover data is determined by setting the “Run with PAR file” option on the 
“Model Parameters” screen, discussed below.  Module 3 will be called either “Import Cloud 
Cover” or “Import PAR” according to the setting of this option. 
 
Module 4: “Import Temperatures” can be used to import a file specifying hourly temperatures 
for all cells in the domain and all hours for which emissions are to be estimated.  The user must 
either import a temperature file or alternatively specify a diurnal temperature profile using the 
“simple inputs” option described below.  The temperature data are stored in an Access Table 
called “Temperature”. 
 
Module 5a: “Import LAI” can be used to import a file specifying leaf area index (LAI) for all 
cells in the domain.  The time period for which the LAI is valid is specified in the table “link 
Days”.  If “variable LAI” or “variable leaf age” is selected on the “Model Parameters” form then 
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the user must either import a LAI file or alternatively specify a LAI file using the “simple 
inputs” option described below.  The LAI data are stored in an Access Table called “LAI”. 
 
Module 5b: “Import Wind Speed” can be used to import a file specifying hourly wind speed for 
all cells in the domain and all hours for which emissions are to be estimated.  If “leaf 
temperature” is selected on the “Model Parameters” form then the user must either import a wind 
speed file or alternatively specify a diurnal wind speed profile using the “simple inputs” option 
described below.  The wind speed data are stored in an Access Table called “Wind”. 
 
Module 5c: “Import Humidity” can be used to import a file specifying hourly humidity for all 
cells in the domain and all hours for which emissions are to be estimated.  If “leaf temperature” 
is selected on the “Model Parameters” form then the user must either import a humidity file or 
alternatively specify a diurnal humidity profile using the “simple inputs” option described below.  
The humidity data are stored in an Access Table called “Humidity”. 
 
Module 5d: “Import Drought Index” can be used to import a file specifying a drought index for 
all cells in the domain.  The time period for which the drought index is valid is specified in the 
table “link Days”.  If “drought index” is selected on the “Model Parameters” form then the user 
must either import a drought index file or alternatively specify a drought index file using the 
“simple inputs” option described below.  The drought index data are stored in an Access Table 
called “DIndex”. 
 
Module 5e: “Import Antec. Temperature” can be used to import a file specifying hourly 
antecedent temperatures (the average temperature for the last 24, 48 and 360 hours) for all cells 
in the domain and all hours for which emissions are to be estimated.  If any of the four 
“antecedent temperature” options are selected on the “Model Parameters” form then the user 
must either import an antecedent temperature file using this module or alternatively calculate an 
antecedent temperature file using the imported temperature file and the “antecedent temperature” 
option described below.  The antecedent temperature data are stored in an Access Table called 
“AnTemp”. 
 
Module 6: “QA Inputs”, performs a series of checks to make sure that the data required for 
calculating emissions are self-consistent. First, it ensures that the land use  (LU) data are 
consistent with the internal model data tables that specify attributes of LU categories.  It then 
checks that there are LU data in the model for every LU code in your land use input.  It then 
checks to make sure that you have temperature and cloud clover (or PAR) defined for every cell 
and hour (within the hour range specified in the “Model Parameters” screen).  If any errors are 
encountered, they are reported and you will be required to fix these errors before proceeding. 
 
Module 7: “Calculate Emissions”, calculates biogenic emissions according to the emission 
factor model algorithms selected on the “Model Parameters” screen.  Emissions are calculated 
for species called ISO (isoprene), TMT (total monoterpenes), OVC (other VOCs) in mg carbon 
per m2 per hour and for NOx and NH3 in mg N per m2 per hour.  The emissions are stored in an 
Access Table called “Emissions.”  You can generate reports of ISO, TMT, OVC, NOx and NH3 
in tons by running one of the reports provided in GloBEIS called “Native Emission Totals by 
Hour in Tons” or “Native Emission Totals by Cell in TONS” (discussed under Reports). 
 
Module 8: “Speciate Emissions”, converts the emissions estimates produced by Module 6 to a 
format suitable for output in Module 9.  There are four speciation options in GloBEIS3.2 that are 
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selected on the “Model Parameters” screen.  The native option outputs the actual emissions 
calculated by GloBEIS in kg and may be used to calculate emissions totals in tons.  The CB05, 
CB4 and SAPRC99 options output emissions as moles of species used in lumped chemical 
mechanisms and are intended to support photochemical modeling.  There are GloBEIS reports to 
summarize emissions by cell and by hour for all four speciation options.  You can only run 
emission reports or export emissions for (say) the CB4 option is you have run Module 8 for this 
option.  It is possible to run Module 8 several times and obtain reports and/or output emissions 
for (say) other options such as CB05, the native and SAPRC99. 
 
Module 9: “Export Emissions” will take either the “CB05 Emissions”, “CB4 Emissions” or 
“SAPRC99 Emissions” Table and export it to a comma delimited ASCII file.  The name for the 
exported file is specified in the “Model Parameters” screen.  The ASCII format of this file is not 
directly compatible with CAMx or UAM, however a simple FORTRAN post-processor called 
BEIS2BIN is provided with GloBEIS to convert the ASCII file to model ready binary format. 
 
Module 10: “Cleanup”, can be run to delete any tables you may have generated from running 
GloBEIS.  This can be used to clean up between tasks.  Clean up is necessary because the Tables 
produced in a GloBEIS run can be large and these Tables are automatically stored in the Access 
database file (normally called globeis_v3.2.mdb) on the hard-drive.  Thus, globeis_v3.2.mdb 
may grow in size from a few Mb to more than a hundred Mb in the course of a model run.  Even 
after “Cleanup” is run the size of the globeis.mdb file is not automatically reduced because 
Microsoft Access does not automatically reclaim space freed up when Tables are deleted.  After 
running “Cleanup”, we recommend you compact the database by running: “Tools” -> “Database 
Utilities” -> “Compact Database” from the Microsoft Access menu.  This will shrink the size of 
the globeis_v3.2.mdb file on your hard-drive. 
 
Run Modules:  The Run Modules button runs all of the modules that the User has selected with 
a check mark on the Banner screen.  Modules are run in the order that they appear on the screen.  
When the “Run Modules” button is clicked, the “Model Parameters Screen” is automatically 
closed to ensure that GloBEIS is run with the most recent model parameters entered. 
 
Quit: To quit GloBEIS3, click the “Quit” button on the banner screen.  This will close the 
globeis_v3.2 database and exit you from Access 2000. 
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MODEL PARAMETERS 
 
The final section of this report provides guidance on what model parameters to select.  The 
purpose of this section is to explain how to select parameters. 
 
The first step in setting up the model parameters is to enter the paths of all your input files on the 
“Input/Output Files” section of the “Model Parameters” screen (see Figure 6 for an example).  
The question marks to the right of each file name open file locator dialogs that enable you to 
browse to locate input files.  Note that Microsoft Access does not consistently allow file names 
that have more than eight characters in the prefix and three in the suffix.  In testing GloBEIS, it 
was found that long file names worked on some Access installations, but not on others.  The 
GloBEIS test problems use only short (8.3) filenames for this reason.  Users may experiment 
with using long file names.  If you have trouble finding a file that you know is there, or you get 
an error when you try to import a file, try using short file names.  Note also that GloBEIS 
running on Microsoft Access does not consistently allow file names with suffixes other than 
“.txt”.  You should make sure all files are names have a “.txt” extension. 
 
There are check boxes on the “Model Parameters” section of the “Model Parameters” screen 
which operate by toggling on and off.  To select any of these options, point and click your mouse 
on the box so that a check mark appears in the box.  To remove any options, point and click the 
mouse on the box so that it is empty.  The first step is to select one of the three models: BEIS2, 
modified BEIS2, or GloBEIS3.  “BEIS2” generates results that are approximately equal to the 
BEIS2 model.  “Modified BEIS2” uses procedures that are the same as BEIS2 except that two 
coefficients in the canopy light model can be specified. “GloBEIS3” uses the canopy model and 
emission algorithms described by Guenther et al. (1999, 2000), and allows the user to select from 
a number of options.  There are three types of options: 1) those available for all options (Figure 
3), 2) those available for “modified BEIS2” (Figure 4), and 3) those available for GloBEIS3 
(Figure 5).  
 
 
Options available for all models: 
 
The “Output Emission Speciation” drop-down allows the user to specify the method used to 
speciate the biogenic emissions.  The four speciation options available are “CB05”, “CB4,” 
“SAPRC99,” and “Native.”  Selecting native emissions means that Module 8 (Speciate 
Emissions) will preserve the native GloBEIS VOC speciation of isoprene, other VOC (OVC) and 
total monoterpenes (TMT) and Module 9 (Export Emissions) will output this information in kg.  
Selecting CB05, CB4 or SAPRC99 will convert the native emissions to the lumped species of the 
Carbon Bond 05 (CB05), Carbon Bond 4 (CB4) or Statewide Air Pollution Research Center 
1999 (SAPRC99) chemical mechanism and output the emissions information in units of moles. 
 
The “Run with PAR File” check box allows you to select whether to specify PAR by importing 
PAR values or fractional cloud cover.  If “Run with PAR File” is off, the third module on the 
banner screen will read “3 Import Cloud Cover”.  If “Run with PAR File” is on, the third module 
on the banner screen will read “3 Import PAR”. 
 
The model parameters “# of Canopy Layers” and “Isoprene EF Adjustment” (see descriptions 
below) are constants used in the calculation of the estimated biogenic emissions.  If you modify 
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any of these constants, you can reset them to their original default values by pressing the “Reset 
to Defaults” button just to the right.  The significance of these parameters is as follows: 
 

• “Number of layers” is the number of layers modeled within the canopy.  GloBEIS does a 
Gaussian integration if the user selects 3 or 5 layers, which are usually sufficient.   

 
• “Isoprene EF Adjustment” is a knob to adjust the isoprene emission rates as necessary for 

the specific application.  In most cases, the appropriate value for this variable is “1.” 
 
The time zone is used in GloBEIS to synchronize the solar time with the times used on hourly 
specific inputs, namely temperature, cloud cover and/or PAR.  For example, if these input files 
are specified in Standard Time, then New York has a time zone of 5 and Los Angeles has a time 
zone of 8. 
 
The “Year” and “Julian Day” fields specify the day for which emissions are calculated.  These 
must match the dates specified on the day specific input files, namely temperature, cloud cover 
and/or PAR. 
 
The  “Year”, “Start Day”, “End Day”, “Start Hour” and “End Hour” fields allow you to run the 
model for a range of hours, days, and years.  By convention, a full day starts with hour 0 and 
ends with hour 23.   If you limit the number of hours, when you import files GloBEIS will only 
keep the hours of input within the range specified in these fields.  If you later decide that you 
want to calculate emissions for a greater range of hours, the model will inform you that you need 
to re-import your inputs to include the broader range of hours.  You may import a broad range of 
hours and then calculate emissions for a subset of those hours. 
 
 
Options available for “modified BEIS2”: 

 
1.  “Extcoeff” is an extinction coefficient used to estimate decreases in PAR within the 

canopy.  BEIS2 uses a value of 0.6 but recommended values vary for different vegetation 
canopies.  

2.  “Cosla” is the cosine of the mean leaf angle. BEIS2 uses a value of 1 but a random leaf 
distribution, which is recommended for most canopies, requires a value of 0.5. The use of 
“cosla”=0.5 is recommended and results in estimates of within-canopy PAR that are more 
realistic than those estimated by BEIS2 and results in lower isoprene emissions.   
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Options available for “GloBEIS3”: 
 

1. “Variable LAI” allows the user to input LAI estimates for each grid cell, and different 
values for different days, rather than use a single value to represent each vegetation type.  

2. “Variable leaf age” uses the model algorithms described by Guenther et al. (1999, 2000) 
to describe isoprene emission variations associated with leaf phenology.  Young and old 
leaves are assumed to have lower isoprene emission rates. 

3. “Drought Index” allows the user to enter a drought index value for each grid cell, and 
different values for different days. Isoprene emission rates are reduced for extreme 
drought levels.  However, increasing drought increases estimated stomatal conductance, 
which typically results in higher leaf temperatures (if the “leaf temperature” option is 
selected), and thus higher emissions of all VOC.   

4. “Leaf temperature” invokes an estimation of the difference between ambient and leaf 
temperature using an energy balance method.  The method is an updated form of the 
model used by Guenther et al. 1999. If this option is selected, then the user can also select 
“Output Energy Balance terms,” which outputs each term in the energy balance and can 
be used to evaluate model performance.   

5. The user can simulate the influence of the past temperature conditions by selecting one of 
the four options for antecedent temperatures: “24 hr”, “48 hr”, “360 hr” or “24, 48, 360 
hr”.  The “24 hr”, “48 hr”, and “360 hr” options are based on the work of Geron et al. 
(2000), Sharkey et al. (2000), and Petron et al. (2001) respectively.  The “24, 48, 360 hr” 
option combines all three algorithms. 

 
 
MOVING BETWEEN GloBEIS SCREENS 
 
The Banner screen is always open, but other screens may be closed or become hidden behind the 
Banner screen.   
 
To open the “Model Parameters” screen, click on the Banner so that the GloBEIS menu (File, 
Reports, Utilities, Data, About) is displayed on the Access menu bar.  Then select “Utilities” -> 
“Edit Model Parameters”.  Alternately, click the “Edit Model Parameters” button at the bottom 
of the GloBEIS banner screen. 
 
Sometimes it is necessary to view the GloBEIS database -- for example, to use the menu 
commands that are native to Access.  When GloBEIS is first opened, the database window is 
minimized in the lower left-hand corner.  The database window can be opened by double 
clicking on it, or your may hit alt-F1 to bring it to the fore.  Alt-F1 is particularly useful if the 
database has gotten lost behind the Banner. 
 
 
INPUT FILE FORMATS 
 
All the input files to GloBEIS3 are in comma delimited ASCII format. These files have several 
features in common: 
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• First Line:  The first line of each file is a “#” sign followed by several commas.  This 
line tells GloBEIS how many data fields to expect on each line of data that follows.  The 
number of commas is the number of data fields minus 1.  This is illustrated in the file 
format examples that follow, e.g. Table 1.  This line is essential and must come first in 
the file. 

• Comment Lines: any number of comment lines are allowed at any point in an input file 
after the first line.  A comment line is designated by putting a “#” sign in the first column 
of the line.  

• Data: data are in comma delimited format, i.e., value1, value2, value3, … 
 
 

Domain Definition File 
 
The domain definition file specifies a geographic area for which emissions are to be calculated.  
In general, the domain is list of geographic objects that are identified by two unique identifiers:  
I-cell and J-cell.  When GloBEIS is being used to prepare emissions inventories for 
photochemical modeling the geographic objects will be a list of grid cells and I-cell/J-cell will 
naturally be the grid cell indices.  GloBEIS is not restricted to processing gridded emissions 
inventories. For example, GloBEIS can be used to process county emissions, in which case the 
list of geographic objects in the domain definition file would be the list of counties, and I-cell/J-
cell would be used to uniquely encode the county identities by (say) setting I-cell to the state 
FIPS code and J-cell to the county FIPS code.  The I-cell and J-cell fields are not required to be 
numeric.  They may be any alpha-numeric combination (not containing commas).  Thus, state 
and county names could also be assigned to indicate a “cell”.   
 
The domain definition file must provide five data fields in this order: I-cell, J-cell, cell area, cell 
latitude (degrees north), cell longitude (degrees west).  The cell area must be provided in square 
kilometers.  We recommend that the latitude and longitude provided should be for the centroid of 
each cell.  An example of the domain definition file format is shown in Table 1.  After this file 
has been imported into GloBEIS the data are stored in a Table called “DomainDefinition”. 
 
Table 1.  Example of the Domain Definition file format. 
#,,,, 
#1:GloBEIS version 3.2 Domain Definition File 
#2: 
#3:Application: Houston area test of GloBEIS3 
#4:Date: March 8, 2003 
#5:Author: Greg Yarwood 
#6:Icell, Jcell, Area (km2), Latitude, Longitude 
48,021,2317.687,30.145,97.312 
48,015,1699.731,29.879,96.295 
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Land Use File 
 
The land use (or land cover) file provides information on how the area of each cell is assigned to 
different land cover categories.  The land use file must define the land use for every cell listed in 
the domain definition file.  It is acceptable for the land use file to include more cells than the 
domain definition file, i.e., you can specify a domain that is smaller than the area for which land 
use data are specified. 
 
The land use requires five fields in this order:  I-cell, J-cell, land use code (LU code), and 
fraction of the cell covered by that LU code.  Note that the sum of all the LU fractions must sum 
to 1.0 for each cell.  If they do not, the model will report the error and indicate which cells need 
to be corrected.  After this file has been imported into GloBEIS the data are stored in a Table 
called “LandUse”.  
 
Table 2.  Example of the Land Use file format. 

 
 
 
 
 
 
 
 
 

 
 
Cloud Cover File 
 
The cloud cover file is optional depending upon whether you have selected to input PAR or 
cloud cover data.  The cloud cover input file requires six fields in this order:  year, day of year, 
hour, I-cell, J-cell, fractional cloud cover (0=clear skies, 1=total cloud cover).    The year and 
day must match the values specified on the Model Parameters screen.  Use the same number of 
digits (i.e., 97 is two digits, 1997 is 4-digits) on both this input file and the Model Parameters 
screen.  The imported cloud cover file is automatically converted to PAR values, so the final 
GloBEIS table from importing a cloud cover file is called “PAR”. 
 
Table 3.  Example of the Cloud Cover file format. 

 
 
 
 
 
 
 
 
 
 
 
 

#,,, 
#1:GLOBEIS version 3.2 Land Use File 
#2:Application: Houston area test of GloBEIS3 
#3:             Landuse data from the TCEQ and BELD3.1 databases 
#4: Icell, Jcell, LUcode, Fraction                                    
   1,   1,  23213, 0.3213990 
   1,   1,  23215, 0.1024740 
   1,   1,  23211, 0.0036160 
   1,   1,  23216, 0.0375450    

#,,,,, 
#1: GloBEIS v3.2 Cloud Cover File 
#2: File created by TMPCLD for simple inputs 
#3: Cloud cover fraction, between zero and one 
#4: 
#5: year, day, hour, icell, jcell, Cloud 
  0,200,  0,  1,  1, 0.800 
  0,200,  0,  1,  2, 0.800 
  0,200,  0,  1,  3, 0.800 
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PAR File 
 
The PAR file is optional depending upon whether you have selected to input PAR or cloud cover 
data.  The PAR input file requires six fields in this order: year, day of year, hour, I-cell, J-cell, 
PAR (W/m2).  The year and day must match the values specified on the Model Parameters 
screen.  Use the same number of digits (i.e., 97 is two digits, 1997 is 4-digits) on both this input 
file and the Model Parameters screen.   After this file has been imported into GloBEIS the data 
are stored in a Table called “PAR”. 
 
Table 4.  Example of the PAR file format. 
 
#,,,,, 
#1:GloBEIS version 3.2 PAR File 
#2: 
#3:Application: Test Problem 
#4:Date: Dec 21, 2001 
#5:Author: Alex Guenther 
#6:year, day, hour, icell, jcell, PAR (W/m2) 
1997,197,0,48,015,220.5 
1997,197,0,48,021,220.5 
1997,197,1,48,015,220.5 
1997,197,1,48,021,220.5 
 
 
 
Temperature File 
 
The temperature input file requires six fields in this order:  year, day of year, hour, I-cell, J-cell, 
temperature in degrees Kelvin.  The year and day must match the values specified on the Model 
Parameters screen.  Use the same number of digits (i.e., 97 is two digits, 1997 is 4-digits) on both 
this input file and the Model Parameters screen. After this file has been imported into GloBEIS 
the data are stored in a Table called “Temperature”. 
 
Table 5.  Example of the Temperature file format. 

 
 
 
 
 
 
 
 
 
 
 

 

#,,,,, 
#1: GloBEIS v3.2 Temperature File 
#2: File created by TMPCLD for simple inputs 
#3: Temperature in Kelvin 
#4: 
#5: year, day, hour, icell, jcell, Temper 
  0,200,  0,  1,  1, 300.0 
  0,200,  0,  1,  2, 300.0 
  0,200,  0,  1,  3, 300.0 
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LAI File 
 
The LAI input file requires six fields in this order:  year, day of year, I-cell, J-cell, current LAI 
(m2/m2), prior LAI (m2/m2), days between.  The “current LAI” represents the value for the 
given day while “prior LAI” is the value representative of an earlier time (specified by the “ days 
between” variable”).  For example, if the prior LAI is the LAI from 30 days earlier than the 
current LAI then the “days between” would be 30.  The year and day must match the values 
specified on the Model Parameters screen.  Use the same number of digits (i.e., 97 is two digits, 
1997 is 4-digits) on both this input file and the Model Parameters screen.  After this file has been 
imported into GloBEIS the data are stored in a Table called “LAI”. 
 
Table 6.  Example of the LAI file format. 

 
 
Wind Speed File 
 
The wind speed input file requires six fields in this order:  year, day of year, hour, I-cell, J-cell, 
wind speed in meters per second.  The year and day must match the values specified on the 
Model Parameters screen.  Use the same number of digits (i.e., 97 is two digits, 1997 is 4-digits) 
on both this input file and the Model Parameters screen. After this file has been imported into 
GloBEIS the data are stored in a Table called “Wind”. 
 
Table 7.  Example of the Wind Speed file format. 
 
#,,,,, 
#1:Globeis version 3.2 Wind Speed File 
#2: 
#3:Year, Day, Hour, Icell, Jcell,Wind Speed(m/s) 
  0,200,  0,  1,  1, 4.000 
  0,200,  0,  1,  2, 4.000 
  0,200,  0,  1,  3, 4.000 
  0,200,  0,  1,  4, 4.000 
 
 

#,,,,,, 
#1:GLOBEIS version 3.2 LAI File 
#2: 
#3:Application: Texas 
#4:Date: Feb 2002 
#5:  
#6:Year, Day , Icell, Jcell, current LAI, prior LAI,  days between LAI data 
 0, 200, 1,  1, 0.806, 0.985,    8 
 0, 200, 1,  2, 1.138, 1.339,    8 
 0, 200, 1,  3, 1.204,     1,    8 
 0, 200, 1,  4, 1.973, 1.545,    8 



November 2007 
 
 
 
 

G:\Globeis\Version3.2\user_globeis32_06nov07 (2).doc 16 

 

 

 

Humidity File 
 
The humidity input file requires six fields in this order:  year, day of year, hour, I-cell, J-cell, 
humidity in grams per kilogram.  The year and day must match the values specified on the Model 
Parameters screen.  Use the same number of digits (i.e., 97 is two digits, 1997 is 4-digits) on both 
this input file and the Model Parameters screen. After this file has been imported into GloBEIS 
the data are stored in a Table called “humidity”. 
 
Table 8.  Example of the Humidity file format. 
 
#,,,,, 
#1:Globeis version 3.2 Humidity File 
#2: 
#3: 
#4:Year, Day, Hour, Icell, Jcell, Humidity(g/kg) 
  0,200,  0,  1,  1,10.000 
  0,200,  0,  1,  2,10.000 
  0,200,  0,  1,  3,10.000 
  0,200,  0,  1,  4,10.000 
 
 
Drought Index File 
 
The drought index input file requires five fields in this order: year, day of year, I-cell, J-cell, 
palmer drought index (non-dimensional).  The year and day must match the values specified on 
the Model Parameters screen.  Use the same number of digits (i.e., 97 is two digits, 1997 is 4-
digits) on both this input file and the Model Parameters screen.  After this file has been imported 
into GloBEIS the data are stored in a Table called “DIndex”. 
 
Table 9.  Example of the Drought Index file format. 
 
#,,,, 
#1:Globeis version 3.2 Drought Index File 
#2: 
#3: 
#4:Year, Day, Icell, Jcell, Drought Index  
  0,200,  1,  1, -3 
  0,200,  1,  2, -3 
  0,200,  1,  3, -3 
 
 
Antecedent Temperature File 
 
The antecedent temperature input file requires eight fields in this order:  year, day of year, hour, 
I-cell, J-cell, average temperature of past 24 hours in degrees Kelvin, average temperature of past 
48 hours in degrees Kelvin, average temperature of past 360 hours in degrees Kelvin.  The year 
and day must match the values specified on the Model Parameters screen.  Use the same number 
of digits (i.e., 97 is two digits, 1997 is 4-digits) on both this input file and the Model Parameters 
screen. After this file has been imported into GloBEIS the data are stored in a Table called 
“AnTemp”. 
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Table 10.  Example of the Antecedent Temperature file format. 
 
#,,,,,,, 
#1: GloBEIS v3.2 Antecedent Temperature File 
#2: File created by TMPCLD for simple inputs 
#3: Temperatures in Kelvin 
#4: 
#5: year, day, hour, icell, jcell, T24, T48, T360 
  0,200,  0,  1,  1, 300.0, 300.0, 300.0 
  0,200,  0,  1,  2, 300.0, 300.0, 300.0 
  0,200,  0,  1,  3, 300.0, 300.0, 300.0 
 
 
 
CALCULATE ANTECEDENT TEMPERATURES 
 
You can create an antecedent temperature file by calculating 24 hour average, 48 hour average 
and 360 hour average temperatures from the temperature file using the tool provided on the 
GloBEIS menu bar “Utilities” -> “Antecedent temperature” (see Figure 7). 
 
Simply click on “Calculate antecedent temperatures” and the antecedent temperatures will be 
calculated.  Note that if the length of the temperature file is less than the duration of the 
averaging period of the antecedent temperature then the resulting values will represent a shorter 
averaging period.  For example, if the temperature file contains 70 hours of temperature data 
then the “24 hr” and “48 hr” antecedent temperatures will represent the appropriate values but 
the “360 hr” temperature will actually represent an average of less than 360 hours. 
 
 
SIMPLE INPUTS 
 
In some cases you may wish to use a simple approach to specify temperature, wind speed, 
drought index, humidity, LAI and/or cloud cover without making input files external to 
GloBEIS.  You can create simple temperature and cloud cover inputs by the tool provided on the 
GloBEIS menu bar “Utilities” -> “Simple Inputs” (see Figure 7). 
 
At the top of the “Simple Inputs” screen, enter the year and Julian day.  If you have used a 2 digit 
year in your other input files, use the same here.  If you used a 4-digit year, again use the same 
here.  The Julian day should be the same as appears in your other input files.  Enter in each of the 
hourly fields below the temperature (in degrees Kelvin), wind speed, drought index, humidity, 
LAI or fractional cloud cover for each hour of the day.  Then when you are finished, click the 
appropriate button.  Note that if you generate a simple temperature input, then later from the 
Banner select to import temperature, the simple temperature input will be overwritten.  Similarly, 
if you generate a simple cloud cover file and then select to either import cloud or PAR, the 
simple cloud cover input will be overwritten. 
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Figure 7.  Simple inputs screen. 
 
 
REPORTS 
 
When you have run GloBEIS to calculate emissions, there are seven different summary reports 
you can run.  To run any one of these reports click on the GloBEIS Banner screen so that the 
GloBEIS menu (File, Reports, Utilities, Data, About) is displayed on the Access menu bar.  Then 
select the report you want under the “Reports” menu.  The reports are presented in an Access 
window that can be printed or exported to a file. 
 
There are three types of emissions reports for both the Emissions Table and the Speciated 
Emissions Table (either CB05, CB4 or SAPRC99, depending on output specified on Model 
Parameters screen).  You may summarize the total emissions for the entire domain by hour, or 
you may view the emissions for a particular cell by hour.   
There is one report for the Landuse table.  You can view the total area in the domain assigned to 
each land use type.   
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INTERNAL LANDUSE DATA 
 
GloBEIS stores information on land cover classes and vegetation types in four tables.  In the 
distributed version of GloBEIS these tables are set up for the TNRCC databases as described in 
Yarwood et al. (1999).  You may need to modify or replace these tables to use GloBEIS for a 
different geographic area.  As described in the next section, GloBEIS has a built-in utility for 
adding data to these tables.  This section of the User’s Guide describes the contents of the tables.   
 
The first table is the LC code descriptions table as shown in Figure 8.  This table describes each 
land cover category (lc) and specifies the NO and ammonia emission factors.  The contents of 
this table are: 
 

lc – a unique five-digit land cover code 
Description – a description for each land cover class 
NO – the NO emission factor for the land cover class in (µg NO m-2 hr-1) 
NH3 – the ammonia emission factor for the land cover class in (µg NH3 m-2 hr-1) 

 
All of the LC codes used in the landuse file must be included in the LC code descriptions table.  
The NO emission factors in the distributed version are based on the work of Williams et al., 
(1992).  The ammonia emission factor table is not populated in the distributed version of 
GloBEIS. 
 
The second table (Figure 9) is the “lcCode” table which defines the vegetation coverage for each 
land cover category (lc).  Vegetation types are identified using lcVeg codes.  The contents of the 
lcCode table are: 
 
 lc - a unique five-digit land cover code 
 lcVeg – a unique vegetation code 
 LMD – the leaf mass density for each vegetation type in this land cover type (g m-2) 
 
The lc codes in the lcCode table must match those in the LC code descriptions table  
(Figure 8). 
 
The third table is the vegetation code characteristics table as shown in Figure 10.  This is the 
table that defines vegetation types that are recognized by the VOC emissions factor model.  The 
current GloBEIS algorithms work in terms of the BEIS2 species codes (vegib2) and emission 
factors for isoprene, total monoterpenes and other VOCs (Guenther et al., 1993).  The contents of 
the vegetation code characteristics table are:  

vegib2 – the BEIS2 vegetation code  
name – a description for each vegib2 class 
iso – the isoprene emission factor for each vegib2 class 
tmt – the total monoterpenes emission factor for each vegib2 class 
ovc – the other VOC emission factor for each vegib2 class 
LAI – the leaf area index for each vegib2 class 
LMD – the leaf mass density for each vegib2 class 
 

The fourth table (“link lcCode VegCode”) provides the link between the vegetation codes 
specified on the lcCode table (lcVeg) and the vegetation types that are recognized by the VOC 
emissions factor model (vegib2).  This can be a “many to one” relationship in that many lcVeg 
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codes can be cross-referenced to a single vegib2 code, as shown in the example in Figure 11.  
However, it is illegal for a single lcVeg code to be cross-referenced to many vegib2 codes.  The 
contents of the “link lcCode VegCode” table are: 

vegib2 – the BEIS2 vegetation code  
lcVeg – the vegetation code as used in the landuse input file  
Veg Description – a description for each lcVeg class 

 
The “link lcCode VegCode” table in the distributed version of GloBEIS includes cross-
references where the lcVeg code is set equal to the vegib2 code.  This allows you to input vegib2 
codes directly on the landuse file, which can be useful for using GloBEIS with landuse data from 
BEIS2. 
 

 
 
Figure 8.  The LC code descriptions table. 
 
 

Figure 9.  The lcCode table. 
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Figure 10.  The vegetation code characteristics table. 
 
 

 
Figure 11.  The link land cover code to vegetation code table. 
 
 
ADDING TO THE INTERNAL LANDUSE DATA 
 
GloBEIS stores information on the assignment of biomass and species distributions by land 
cover category in Tables in the globeis2.mdb file.  The distributed version of GloBEIS comes 
with data tables that are consistent with the TNRCC landuse databases (Yarwood et al., 1999).  If 
GloBEIS is used with different landuse data these internal Tables may need to be updated.   
 
GloBEIS has a data entry utility that can be used to update the internal landuse databases.  This 
utility adds one new landuse code at a time and ensures that the cross-references between Tables 
are preserved.  This approach is feasible for adding a few new landuse codes, but would be 
tedious for setting up a whole new database.  However, the data entry screens below show the 
relationships between Tables so that you can see how to make extensive new Tables externally 
(using a database, spreadsheet or other tools) and then import them directly to GloBEIS. 
 
From the GloBEIS menu, select “Data” -> “Data Entry”.  This brings up three screens for 
entering land use (LU) data into the model (see Figures 12 through 14).  These screens are called 
“Enter New LC Class,” “Enter New VEGIB2 Class,” and “Enter New LCVeg Class.”  You may 
move from screen to screen as needed.   
 
At the bottom of each of these three screens are record indicators, which tell you which data 
record you are working on and the total number of records in the Table.  For example, in Figure 
14, LCVeg “PITTOB” is the first LCVeg class out of a total of 228 classes in the database.  You 
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can move from record to record by clicking the left and right arrows on the record indicator.  
You move to the last record by clicking the right arrow with a vertical bar.  You move to the first 
record by clicking the left arrow with a vertical bar.  Finally, you start to enter a new record by 
clicking the right arrow with a star.   
 
To enter data, you tab from field to field and type in your data.  If you make an error, you can 
press the “Esc” key, or you can select “Edit” -> “Undo Current Record” from the menu.   
 

 
Figure 12.  Enter New LC Class. 
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Figure 13.  Enter New VEGIB2 Class. 
 
 

Figure 14.  Enter New LCVeg Class. 
 
 
At any time, you may toggle between viewing your data as displayed in Figures 12 through 14 
(i.e., “form view”) or as spreadsheets by selecting “View” -> “Datasheet” or “View” -> “Form” 
from the menu.  Whichever record (or row) is active in the datasheet view or form view will 
remain active when you toggle between the two views. 
 
To delete a record, put your mouse on top of the gray box to the left of the LCVeg field until you 
see a right arrow, then click.  This highlights the entire row, and you may press the delete key.  
Alternatively, select “Edit” -> “Select Record” and then “Edit” -> “Delete” from the menu. 
 
To find a particular record, you can select “Edit” -> “Find” from the menu.  You will get a small 
“Find” window (illustrated in Figure 15), which allows you to search the current field (i.e., the 
one your mouse is in) or all fields.  You can search the whole field, any part of a field, or the first 
part of the field.  Once a match is found, you are automatically shown the record with the match.  
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Figure 15.  Finding records. 
 
 
In Figure 12, there are two record indicators, one for the LC class and another for the associated 
LCVeg classes.  For each LC class, there may be multiple plant species associated with that 
class.  When you move from LC class to LC class in the “Enter New LC Class” window, the list 
of associated LCVeg classes will change in the nested window.  The number of records in this 
nested window will also change according to how many plant species are associated with a given 
LC class.  So, when you enter a new LC class, you will see no associated LCVeg classes below.  
In order to make these associations, click your mouse in the LCVeg field of the nested window 
(or press Ctrl-Tab) until you are in this field.  Select the LCVeg you want to associate with your 
new LC class from the pick list.  Then tab over to the LMD field (leaf mass density) and enter 
your desired LMD value. Note that you may have only one occurrence of a particular land code 
when entering your data, or you will get an error when trying to run the model.  Similarly, for a 
given land code you may list an associated LCVeg class only once (i.e., you can not assign 
ACAFAR to land code 1001 more than once).  This ensures that you will have a unique LMD 
value for each LCVeg class.  If you need to add new LCVeg classes, do this before adding new 
LC classes to ensure that the LCVeg codes will be available on the pick list shown in Figure 12. 
 
Each LC class must be assigned one of the following canopytypes. The canopytype that best 
describes the vegetation in the landcover should be selected. 
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Table 11. Canopytype descriptions. 
 
Canopytype code Description 
1 Broadleaf trees  
2 Mixed broadleaf and needleaf trees 
3 Needleleaf trees 
4 Mixed vegetation 
5 shrubs 
6 grass 
7 crops 
 
 
In Figure 13, “Enter New VEGIB2 Class”, the data entry is conducted by tabbing from field to 
field and typing in your data.  You may find the datasheet view useful for this window.  Note 
that you must make sure that a particular VEGIB2 class appears only once.  If not, you will get 
an error when you try to run the model. 
 
In Figure 14, “Enter New LCVeg Class”, you are associating each LCVeg class with a VEGIB2 
class.  You enter data in this window by first typing in your new LCVeg class.  Then you select 
its associated VEGIB2 class from the pick list to the right.  Once you have selected the 
associated VEGIB2 class, all the information pertaining to this VEGIB2 class appears in the 
nested window on this screen.  The VEGIB2 information is not editable in this window.  You 
must edit the VEIGB2 information in the “Enter New VEGIB2 Class” (Figure 13).  Note that 
you may have only one occurrence of a particular LCVeg class in the “Enter New LCVeg Class” 
window.  If you do not, you will get an error when you try to run the model.  
 
An overview of the data you are entering in the database is shown in Figure 16, “Database 
Structure”.  The “LC Code Descriptions” table is represented by the window “Enter New LC 
Class.”  The table “LCCode lmd” is represented by the nested window in “Enter New LC Class.”  
The table “link lcCode VegCode” is represented by the window “Enter New LCVeg  
Class,” and the table “vegCode char” is represented by the window “Enter New VEGIB2 Class.”  
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Figure 16.  Database structure. 
 
 
In order for the model to accept all your new data, you must follow the following rules: 
 
1) For every LC entered in “Enter New LC Class” (or the “LC Code Descriptions” table), you 

must have corresponding lcVeg entries in the nested window (or entries in the “lcCode lmd” 
table). 

2) For every lcVeg you select in the nested spreadsheet under “Enter New LC Class”, there 
must be an lcVeg in the “Enter New LCVeg Class” window (or the “link lcCode VegCode” 
table). 

3) For every corresponding VEGIB2 you select in the “Enter New LCVeg Class” window, there 
must be a corresponding entry in the “Enter New VEGIB2 Class” window (or the “vegCode 
char” table).   

 
If you are missing any link in items 1 through 3 above, the model will inform you of your 
missing data and will not run. 
 
 
VOC SPECIATION  
 
GloBEIS estimates VOC emissions of isoprene, total monoterpenes (TMT) and other VOCs 
(OVC) by plant species.  If the CB05 (Carbon Bond 05; Yarwood et al., 2005), CB4 (Carbon 
Bond 4; Gery et. al., 1989) or SAPRC99 (Statewide Air Pollution Research Center 1999 fixed 
parameter mechanism; Carter, 2000) speciation scheme is selected on the model parameters 
screen, the emissions are translated to the species of the CB05, CB4 or SAPRC99 lumped 
chemical mechanism.  The translation is trivial for isoprene, which is represented explicitly in 
CB05, CB4 and SAPRC99, but complex for TMT and OVC.  A third choice is to output the 
native GloBEIS VOC speciation directly as isoprene, OVC and TMT.  For the CB05, CB4 and 
SAPRC99 options the emissions are output in molar units whereas for the native option output 
units are kg.  The TMT species has a representative molecular weight of 136.24 and contains 12 
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carbons whereas as OVC has a representative molecular weight of 46.63 and contains 2.19 
carbons, on average.   
 
The TMT and OVC emissions are converted to output VOC species by a two-step mapping.  
First, TMT and OVC are mapped to real VOC species using the VOC speciation scheme 
described by Guenther et al. (1999a; 2003) and shown in Tables 12 and 13.  Then, these real 
VOCs are mapped to the species in the chemical mechanism selected for output (Tables 14 and 
15).  GloBEIS performs the speciation step using composite factors stored in data tables that 
have units “moles of output species per kg carbon of emissions.”  These factors should not be 
changed. 
 
Table 12.  Species assignment for total monoterpenes (TMT). 

Monoterpene Fraction 
α-pinene 0.2829 
β-pinene 0.2039 
Δ3–carene 0.1250 
sabinene 0.0724 
d-Limonene 0.0658 
β-phellandrene 0.0526 
r-cymene 0.0395 
myrcene 0.0263 
camphene 0.0132 
camphor 0.0132 
bornyl acetate 0.0132 
α-thujene 0.0132 
terpinolene 0.0132 
α-terpinene 0.0132 
γ-terpinene 0.0132 
ocimene 0.0132 
1,8-cineole 0.0132 
piperitone 0.0132 

 
 
Table 13.  Species assignment for other VOCs (OVC). 

Other VOC Fraction 
methanol 0.5 
ethanol 0.06 
acetone 0.1 
butanone 0.02 
ethane 0.01 
hexenyl acetate 0.03 
ethene 0.05 
hexenal 0.03 
hexenol  0.03 
acetaldehyde 0.05 
propene 0.04 
butene 0.02 
formaldehyde 0.02 
hexanal  0.02 
acetic acid 0.01 
formic acid 0.01 
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Table 14.  VOC species assignments to CB05 model species. 
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Isoprene 5          1      
Methanol 1        1        
α-pinene 10            1    
methyl butenol 5 1 3              
β-Pinene 10            1    
Δ3 –Carene 10            1    
Hexenylacetate 8  3         1    1 
Ethene 2       1         
Ethanol 2         1       
Acetone 3  3              
hexenal 6             1  1 
hexenol 6  2             1 
propene 3 1 1              
sabinene 10            1    
d-limonene 10            1    
β-phellandrene 10            1    
r-cymene 10  2  1            
myrcene 10            1    
butene 4 1 2              
acetaldehyde 2      1          
formaldehyde 1     1           
hexanal 6  4           1   
camphene 10            1    
camphor 10  8         2     
bornyl acetate   6         6     
α-thujene 10            1    
Terpinolene 10            1    
α-terpinene 10            1    
γ-terpinene 10            1    
ocimene 10            1    
1,8-cineole 10  9         1     
piperitone 10           1 1    
butanone 4  4              
ethane 2              1  
acetic acid 2  1         1     
formic acid 1           1     
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Table 15.  VOC species assignments to CB4 and SAPRC99 model species. 
CB4 Assignment  
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Isoprene 5 ISOP          1  
Methanol 1 MEOH        1    
α-pinene 10 TERP 0.5 6    1.5      
methyl butenol 5 OLE1 1 3          
β-Pinene 10 TERP 1 8          
Δ3 –Carene 10 TERP 0.5 6    1.5      
Hexenylacetate 8 OLE2 1 5         1 
Ethene 2 ETHE       1     
Ethanol 2 ALK3         1   
Acetone 3 ACET  2         1 
hexenal 6 ISPD 1 2    1      
hexenol 6 OLE2 1 4          
propene 3 OLE1 1 1          
sabinene 10 TERP 1 8          
d-limonene 10 TERP 1 4    2      
β-phellandrene 10 TERP 2 6          
r-cymene 10 TERP  2  1        
myrcene 10 TERP 3 4          
butene 4 OLE1 1 2          
acetaldehyde 2 CCHO      1      
formaldehyde 1 HCHO     1       
hexanal 6 RCHO  4    1      
camphene 10 TERP 1 8          
camphor 10 TERP  9         1 
α-thujene 10 TERP 1 8          
Terpinolene 10 TERP 2 6          
α-terpinene 10 TERP 2 6          
γ-terpinene 10 TERP 2 6          
ocimene 10 TERP 3 4          
1,8-cineole 10 TERP  10          
piperitone 10 TERP 1 7         1 
butanone 4 MEK  3         1 
ethane 2 ALK1  0.4         1.6 
acetic acid 2 ALK2  1         1 
formic acid 1 ALK2           1 
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RECOMMENDATIONS 
 
GloBEIS3 provides a number of options and so the following guidance is provided to help you 
decide how to use the model. 
 
Choosing Between BEIS2, Modified BEIS2, and GloBEIS3 Emission Factor Options 
 
GloBEIS3 is the recommended emission factor model.  The GloBEIS3 option corresponds to the 
“BEIS99” option that was available in GloBEIS2.  BEIS2 should be used only if you are trying 
to generate estimates that agree with the BEIS2 model. If you would like to use the BEIS2 
procedures but want to adjust the “cosla” variable (which is not set to a realistic value in BEIS2) 
then the “modified BEIS2” model should be used.  GloBEIS3 must be selected if you want to use 
many of the provided options. 
 
If you are trying to match results from GloBEIS2 with the BEIS99 option, then select GloBEIS3 
with no leaf temperature, leaf age, drought index or variable LAI options. 
 
 
Options Available for All Models 
 
“Number of layers”: 5 is recommended for accurate calculations of canopy radiation transfer.  If 
the model run time is a concern then 3 can be used.  
 
“Isoprene EF Adjustment”: 1 is recommended for accurate calculation of ispoprene emissions. 
 
 
Options Available for “Modified BEIS2” 
 
The recommended value for the canopy extinction coefficient, “Extcoeff”, is 0.6 unless you want 
to simulate a specific type of canopy.  The recommended value for the cosine of the mean leaf 
angle, “Cosla”, is 0.5 unless you want to simulate a canopy that has a non-uniform leaf angle 
distribution. 
 
 
Options Available for “GloBEIS3” 
 
The “Leaf temperature” option is recommended if you have wind speed and humidity data 
available.  The “Output Energy Balance terms” should be selected only if you are interested in 
using these energy flux terms to evaluate model performance.   
 
The “variable LAI” option should be used if you have leaf area index estimates available that are 
more representative than the specified peak LAI estimates that are included in the landcover 
characteristics database. This option is always recommended for months outside of the peak 
growing season. 
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The “variable leaf age” option should be used if you have an available time series of leaf area 
index estimates. It is recommended that the time series used should be at least monthly and no 
more than 5 day. This option is always recommended for months outside of the peak growing 
season. 
 
One of the antecedent temperature options (“24 hr”, “48 hr”, “360 hr” or “24, 48, 360 hr”) 
should be used if you have a temperature time series available and would like to investigate the 
sensitivity of emissions to antecedent temperature.  It should be recognized that although each of 
the options is based on a published quantitative description of the influence of antecedent 
temperature, the relationship between antecedent temperature and emissions is not well 
understood.   
 
The “Drought index” option should be used if you have Palmer Drought Index estimates 
available and would like to investigate the sensitivity of emissions to drought.  It should be 
recognized that the GloBEIS3 is a crude approximation of limited qualitative observations and 
that no quantitative descriptions of the impact of drought on biogenic emissions were available 
for this version.   
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